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Abstract—Many students often find themselves in the panicky and stressful situation where they have too much to learn but too little time to
accomplish it because the exams are fast approaching. They then need to choose which topics to study in the limited time available before the
exam, so that their efforts will yield the best possible result in terms of marks gained in the exam. This paper explains how to use the Solver
tool in the Data menu of MS-Excel to solve this combinatorial optimization problem instantaneously, saving precious time which can now be
better utilized for exam preparation. This also provides the student with a clear action plan and protects the student from wasting time due to
“freezing’ caused by panic on the final day before the exam

1. INTRODUCTION

Many students will be familiar with the following situation — there are only 2 more days to go before the final exam. Ten
chapters will be assessed for the exam, but the student remembers almost nothing. The student does a reality check and estimates
the amount of time required to ‘master’ each chapter, which totals up to 30 hours. But the student can only study for a maximum
of 16 hours until the start of the exam. Assuming that the student knows the marks distribution (weightage) of each chapter to be
tested in the exam, and assuming that the student can maximize the chances of securing the marks allotted for a particular chapter
only if he devotes the entire amount of time required to ‘master’ the chapter according to his original estimate, which chapters
must he choose to study in the limited time available before the exam, in order to enable him to score the maximum possible
marks in the exam?

This is a Combinatorial Optimization problem, which can be solved very easily and automatically after constructing a Linear
Programming Model by using the Solver tool that is available as an extra Add-In called the Analysis Toolpak in MS-Excel. It
can be loaded in MS-Excel by following the instructions given by Niels Weterings (refer the Appendix).

2. FORMULATING THE MODEL

This decision-making problem can be generalized as follows:

Suppose there are n tasks Ty, Ty, ...., Tj, ..., T, to be completed and each task will take time t; where i = 1,2,3,....n. The total
time available for completing ALL the tasks, A becomes the constraint, since A is less than the total time required to complete
ALL the tasks, R which is calculated as £ = I}, The completion of each task generates a particular profit, P;. The goal is to
maximize the total profit P which is the sum of the profits of all the tasks that will be chosen for completion in the available time.

For illustrative purpose, the list of topics is taken from the IB Physics HL curriculum, and the estimated time required to
master/revise each topic is calculated by taking 1/5™ of the recommended teaching hours for each topic prescribed by the 1B
subject guide. Assuming that the student is preparing for the final summative exam in which he/she will be tested on all the
topics, and assuming a more or less uniform coverage of all the topics in the exam, marks distribution for the summative
assessment was done. All this information is added in the REQUIREMENTS section of the table in the EXCEL spreadsheet as
shown in Figure 1.



An Application of MS-Excel to Solve Optimisation Problems — Exam Study Optimiser

321

[N}

o U s W

B

C

REQUIREMENTS

F
SELECTION

Study time

required for

revision

1B before the 1: will study the

IB Physics Topics that |[recommended |exam for % marks topic
will be tested in the teaching hours |each allotted for 0: will skip the topic
Exam for each topic [topic/hours |each topic
1. Measurements and
uncertainties 5 1 5 1
2 Mechanics 22 4 10 1
3 Thermal physics 11 2 5 0
4 Waves 15 3 5 0

5 Electricity and
magnetism

15

6 Circular motion and
gravitation

7 Atomic, nuclear and

9 | particle physics

8. Energy production

9(HL) Wave
phenomena

17

10(HL) Fields

i

11(HL) Electromagnetic
Induction

16

12(HL) Quantum and
nuclear physics

16

Option D Astrophysics

25

Total

180

100

Total time available for study / hours =

Total marks prepared for /100 [should be maximi:

dl =

71|

Figure 1 Implementing the model in MS-Excel

The total time available for study (in hours) is determined by the user and is set as the constraint for the model. It will
depend on how late the student starts the preparation for the exam, and how much study-time is available before the

commencement of the exam.

The values in the SELECTION column and “Total marks prepared for” will be populated automatically by MS-Excel on

using the SOLVER tool based on the information provided in the REQUIREMENTS section.

The following three questions must be answered in order to formulate this linear programming model:

1. What are the decisions to be made? In this problem, we need Excel to choose the topics to be studied (1 = study the

topic, 0 = skip the topic).

2.  What are the constraints on these decisions? Each topic has to be either chosen (1) or not chosen (0) for study, which
makes it a binary output variable. These decisions will determine the total time spent studying the selected topics, which
must be less than or equal to the total time available for studying.

3. What is the overall measure of performance for these decisions? It is the total marks that can be prepared for based on
the topics chosen for study. The goal is to maximize this quantity.

To make the model easier to understand and to manipulate the data for calculation using formulae, the range of cells
containing the different data were named as follows (right click on the selection of cells to be named, and select ‘Name a Range’

in the pop-up window):

The functions were entered in the cell addresses as shown in Figure 3 to perform the calculations.

Figure 2 Variables used in the model

Range Name Cells
required_time C3:C15
marks_allotted D3:D15
total_required_time C16
total_allotted_marks D16
total available time F18
topics_selected F3:F15
time_spent F16
Marks_prepared_for F19
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Figure 3 Functions used to evaluate the variables

Functions inserted Cell Address Variable calculated
=SUM(B3:B15) B16 Total IB recommended teaching hours for all the topics
=SUM(C3:C15) C16 total_required_time
=SUM(D3:D15) D16 total_allotted_marks
=SUMPRODUCT (required_time,topics_selected) F16 time_spent
=SUMPRODUCT (marks_allotted,topics_selected) |F19 marks_prepared_for

The SUM function adds all the numbers in a range of cells, while the SUMPRODUCT function returns the sum of the
products of the corresponding ranges or arrays. Thus, total time spent studying the selected topics is calculated by the sum of the
products of the time required for each topic and the corresponding binary value of the topic selection status (0 or 1). The total
marks prepared for as a result of choosing the topics is calculated by the sum of the products of the marks allotted for each topic
and the corresponding binary value of the topic selection status (0 or 1).

The optimal solution (selection of topics which will maximise the total marks prepared for) was found by using the Solver in
the Data menu of MS-Excel as follows.
Study Optimiser Database_GYA_v01 - Microsoft Excel — 1

‘ormulas Data Review  View  Developer Foxit Reader PDF L7

E JF 4 Clear é g B S5 9 Group~ ¥= _‘EDataAnalysis
A o Reapply ——= ' _E:El @ Ungroup ~ = ?QSolver

ort Filter 7 ' Textto Remove |53 [
Ad d - =2~ || ] Subtotal
-/ Advance Columns Duplicates —* él—l Hbtot

Sort & Filter Data Tools Outline £ Analysis

Figure 4 Click on Solver in the Analysis group of Data tab

Solver Parameters X
Set Target Cell: s
Equal To: ®Max (O Min () Value of: 0 Close

By Changing Cells:
topics_selected B Guess
Subject to the Constraints: Options
time_spent <= total_available_time Add
topics_selected = binary =
Change
Reset All
Delete
Help

Figure 5 Enter the Solver Parameters in the Pop-Up window as shown

‘marks_prepared_for’ (cell F19) was selected for ‘Set Target Cell’, and the condition was set as ‘Equal To’ ‘Max’ (selected
the Max radio button). This condition was achieved ‘By Changing Cells’ to ‘topics_selected’. The constraints were set one by
one by clicking on the ‘Add’ button.
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Change Constraint X

Cell Reference: Constraint:
S <= |~ | =total_available_time T

Cancel Add Help

Figure 6 Setting the constraint for time_spent

‘time_spent’” was set to be less than or equal to ‘total_available_time’, and

- -~ -

Change Constraint X

Cell Reference: Constraint:
topics_selected E&| bin |~ | =binary =
Cancel Add Help

Figure 7 setting the oonstraint for topics_selected

‘topics_selected’ was set as binary variable so that it can take only 0 or 1 as values. Next, ‘Options’ button was clicked and
‘Assume non-negative’ checkbox was selected in the Solver Options popup window.

Solver Options X
Max Time: 100 seconds 0K |
Iterations: 100 Cancel
Precision: 0.000001 Load Model...
Tolerance: 5 % Save Model...
Convergence: 0.0001 Help
[ ] Assume Linear Model [ ] Use Automatic Scaling
Assume Non-Negative [ ] Show Iteration Results

Estimates Derivatives Search
(® Tangent (®) Forward (®) Newton
(O Quadratic (O Central () Conjugate

Figure 8 Selecting 'Assume Non-Negative' in the Solver Options

Finally, the Solve button was clicked to see the optimal solution for the current value of total available time for study. By
changing the value of ‘total_available_time’ (cell F18) from 1 to the maximum possible value of ‘total_required_time’ in
increments of 1, and clicking on the Solve button each time, one can obtain the optimal solution for all the possible values of
total available time. The % marks prepared for was found to increase almost linearly with the % of required time which was
available for study, as expected.
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Figure 9 % marks prepared for vs % of required time available for study

3. CONCLUSION

The Solver tool of MS-Excel can be used to instantaneously decide which topics to be studied out of a collection of topics if the
estimated time required to complete each topic and the approximate marks distribution or weightage for each topic in the exam is
known, along with the total time available for study. This automation of the decision-making process can save precious time for
the student when he/she is preparing for the exam and very little time is left. By showing a clear plan of action as to which topics
to study and which topics to skip for the optimum utilization of the available scarce time to maximise the gain in terms of
possible marks that can be scored in the exam, it reduces and/or prevents the onset of stress and panic for the poorly prepared
student when the exam is fast approaching. The Solver tool of MS-Excel is a very powerful and versatile tool which can be used
to solve many such decision-making optimization problems easily and quickly.
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Appendix

How to load Solver in MS-Excel (Niels Weterings, 2010)
“1. On the File tab in MS-Excel, click Options.

2. Under Add-ins, select Solver Add-in and click on the Go button.

Excel Options ? X
G I . . . .
= _-_;'} View and manage Microsoft Office Add-ins,
Formulas -
Proofing Add-ins
Save Mame = | Location [ Type [«]
Language Active Application Add-ins
Mo Active Application Add-ins
Advanced
c i~ Ribb Inactive Application Add-ins
ustomize Hibbon Analysis ToolPak Ci32XLL  Excel Add-in
Cuick Access Toolbar Analysis ToclPak - VBA Ch W XLAM Excel Add-in
Date (XML) ChuGFLDLL  Action
Add-ins Euro Currency Tools TG XLAM Excel Add-in
Inquire Cheimdlil COM Add-in
Trust Cent
s e Microsoft Actions Pane 3 AML Expansion Pack
Microsoft Power Map for Excel ChGLLDLL COM Add-in
Microsoft Power Pivot for Excel Chdindll COM Add-in
Microsoft Power View for Excel Chueentdll COM Add-in
Solver Add-in Excel Add-in -
Add-in: Sohver Add-in
Publisher:
Compatibility: Mo compatibility information available
Location: Ch\Program Files\Microsoft Office\root\Officel8\Librang,
SOLVER\SOLVER.XLAM
Description:  Tool for optimization and equation sclving
Manage: | Excel Add-ins "'| Go.. k

| oK | | Cancel
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3. Select Solver Add-in checkbox and click OK.

Add-ins ? *

Add-ins available:

DAnalysis ToalPak oK
[ &nalysis ToalPak - VBA
|;|Euro Currency Tools Cancel
A
Browse..,
Automation...
Salver Add-in

Tool for optimization and equation solving

4. You can find the Solver on the Data tab, in the Analyze group.

lj"? @ '} {'Ilz{ HEE Show Detail || %5 Solver
. Hide Detail
What-If Forecast Group Ungroup Subtotal
Analysis = Sheet = =
Forecast Cutline

P Analyze |«

Link to download Exam Study Optimiser (customised MS-Excel Spreadsheet developed in this
research)

https://tinyurl.com/yaaghxgo
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